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Class Description:
Have you ever tried to control the shape of a curved form parametrically in the Family Editor? If so you
have no doubt discovered that flexing them sometimes throws you a curve ball. In this session, we will
explore several techniques to tame your unruly parametric curves. We will look at examples of circles,
arcs, quarter round, half round, arches and even throw in some splines. We will look at both simple and
compound curves. We will work primarily in the traditional Family Editor but will discuss how techniques
apply to the massing Family Editor environment as well. We will explore curvature, rotation and throw in
some trigonometry for good measure. After this session, I cannot guarantee that you will never have
another misbehaving curve in your family content, but what I can promise is that you come away with
several useful tools to help you tame them when curve mischief strikes!

Learning Objectives

At the end of this class, you will be able to:
•

Take your family editor skills to the next level

•

Learn to create flexible parametric curved forms in the family editor

•

Componentize your families: reuse the parts and pieces

•

Use formulas and other advanced techniques to control family curves
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Throw your Family a Curve

About this paper
As a handout for this class, I have included Chapter 4 (in its entirety) from my latest book:
Renaissance Revit: Creating Classical Architecture with Modern Software.
The subject of chapter 4 involves creating parametric curves in the Revit family editor and is
therefore perfect for this class. The chapter is 100% tutorial based. I also have files available for
your use with this paper.
You can download the ZIP file from here:
https://app.box.com/s/ytvc1imjx05lh7kuj99u

You can contact me at:
Website: www.paulaubin.com
Email: paubin@paulaubin.com
Twitter: @paulfaubin

Thank you!

If you are interested, my other paper from Minnesota University 2014 can be found here:
Parametric Classical Orders: A journey with the Revit family editor.
https://app.box.com/s/qs1v6tchhju4lds63pzc
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Chapter 4

Constraining Curves

INTRODUCTION
Families like straight lines. I don’t have this on absolute fact, but rather on personal experience. Controlling the
location of straight lines is easily accomplished in the Family Editor using simple reference planes or reference
lines. When you introduce curves: arcs, circles and ellipses it becomes a little more difficult to control them
parametrically in a reliable and stable way. Techniques and procedures designed to address this issue are what
this chapter is all about.

OBJECTIVES
In this chapter we will explore several exercises designed to assist you in understanding how curves and rotation
behave and then how to ensure that when you introduce curved forms or rotating elements into your family
content that you can control the curvature and rotation predictably and reliably. Topics in this chapter include:
• Understand the challenges inherit in curves
• Apply parameters directly to curves
• Explore when to use references and rigs
• Understand how to apply complex formulas
• Learn to effectively use profile families

CURVATURE IN THE TRADITIONAL FAMILY EDITOR
This chapter focuses on techniques in the traditional family editor environment. Lessons in the chapter are
cumulative from the lessons in the previous chapters. If you are not familiar with the basics of the traditional family
editor, establishing reference planes, creating labeled dimensions and parameters and building 3D forms and voids,
you are encouraged to review the previous chapters before continuing. This chapter will not explore the massing
family editor environment. As such, when we speak of curvature in the family editor in this chapter, we are speaking
of two-dimensional curves confined to the active work plane that include: circles, ellipses, arcs (portion of a circle),
elliptical arcs (portion of an ellipse) and splines (Bezier splines with control handles) (see Figure 4.1).

FIGURE 4.1

Curves available in sketch mode for solid and void forms in the traditional family editor
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These are the shapes you can use in the five solid and void forms available to us in the traditional family editor.
(Examples of each of the five forms were showcased in the previous chapter). Throughout the lessons in this chapter,
we will explore several isolated scenarios first and then combine techniques together to create more complex forms.

CONSTRAINT AND PARAMETER DIRECT ATTACHMENT
The general rule-of-thumb in family creation is to create a clear and consistent hierarchy between the references,
constraints and geometry. Typically this means that you would want to lay down your reference planes and reference
lines first. You would next apply constraints and parameters to these references and flex them to be sure that they
function properly. Finally, you would build your geometry and lock it to this properly flexing armature of references.
This is the so-called “bones, muscle and skin” analogy. It is my experience that this is often the best approach in
most situations. However, as with any rule or guideline there are always exceptions. In the next few lessons, we’ll
look at a few examples where the dimensions (be they constraints or parameters) will be applied directly to the
geometry instead of a reference. The general rule should still be followed: if you can dimension your reference lines
or reference planes first, and then attach geometry to them, it is generally preferred. But as we will see, this is not
always possible or desirable, particularly when curves are involved.

CREATE A PARAMETRIC CIRCLE
Two forms that will use the direct attachment method will be circles and ellipses. To parametrically flex and or
reliably constrain these elements, we typically need to apply the dimensions directly the forms.
1.

From the Application menu, choose Open > Family.

2.

Browse to the Seed Families folder, select the file named: Family Seed (Instance Based).rfa and then click Open.



Type WT and then ZA.

3.

Save the file in the Chatper04 folder as: Circle.

All solid and void forms in the Family Editor can use circles. So you can perform the following procedure on any
kind of form. To keep the exercise simple, we’ll use an extrusion, but feel free to practice the steps on other forms
as well later on. Since the seed already contains an extrusion we can simple edit it.
Work in the Ref. Level floor plan view
4.

Select the extrusion onscreen.



On the Modify | Extrusion tab, click the Edit Extrusion button.



Select and delete the four existing sketch lines.

5.

On the Draw panel, click the Circle icon.



Draw the circle centered on the reference planes in the file. Snap the size of the circle to the width and depth
defined by the reference planes (see Figure 4.2).
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FIGURE 4.2

Draw a circle and snap it to the reference planes

Even though we snap the circle to the reference planes, it will not flex when the parameters flex. Try it out if you
like. Instead we have to add another parameter to make our intentions known to Revit. We will add a radius
dimension and parameter directly to the circle.
6.

Click the icon beneath the dimension to make the temporary dimension permanent. Click the Modify tool to cancel.

7.

Label this dimension with a new instance based parameter and call it: R (see Figure 4.3).

FIGURE 4.3

Create the dimension and a radius parameter
8.

Finish the extrusion.

We could flex the extrusion now to be sure that it works, but since we already have the Width and Depth parameters
that represent the overall extents of the circle, let’s add a few simple formulas in the “Family Types” dialog to tie all
three parameters together so they flex in a logical way. We want Width and Depth to be equal, and R to be half of
Width and Depth.
9.

Open the “Family Types” dialog.

10. In the Formula column next to Width, Type: Depth. For the Formula next to Depth, type: R * 2 (see Figure 4.4).
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FIGURE 4.4

Link the three parameters with formulas

Note: We are ignoring the Base Diameter parameter for the time being. If you prefer, you can set the Width and Depth
equal to Base Diameter times a multiplier.
11. Flex the family.

The circle should change size as you flex the radius. The width and depth should also flex with the radius.
Note: If you prefer, you can use the Diameter dimension tool on the circle and thereby eliminate the need for the
formula based on the R parameter. In this case, the diameter can be set equal to the either the Width or Depth
parameter directly.

CATCH UP! You can open a file completed to this point named: 04_Circle.rfa.

CREATE A PARAMETRIC ELLIPSE
Creating a parametric ellipse is very similar. For this one, we’ll tie the width and depth separately to each ellipse
axis. Otherwise, the procedure is nearly the same.
Continue in the previous file or open the catch-up file.
1.

Save the file as: Ellipse.

2.

Open the “Family Types” dialog.



Clear the formulas.

3.

Select the R parameter and then click Modify.



Rename it to: X and then click OK. For the Formula, type: Width / 2.

4.

Add another instance based Length parameter named: Y.



For the Formula, type: Depth / 2 and then click OK (see Figure 4.5).
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FIGURE 4.5

Edit the parameters to prepare them for the ellipse

The parameters are now ready, let’s edit the extrusion next.
5.

Select the circle extrusion and then on the ribbon, click the Edit Extrusion button.



Select the circle sketch and delete it.

6.

On the Draw panel, click the Ellipse icon and then click the center point at the center of the square.

7.

Snap the first ellipse axis to the intersection of the Center (Front/Back) and Right reference plane. Snap the
other axis to the intersection of the Center (Left/Right) and Back reference planes.

8.

Make both dimensions permanent (see the left side of Figure 4.6).

FIGURE 4.6

Draw an ellipse and make the dimensions for both axes permanent

At the moment, this ellipse looks like a circle. Mathematically, a circle is really just a special case of an ellipse. So
you can actually use an ellipse all the time if you prefer and when you need a circle just flex it so that both axes are
equal. Let’s finish it and flex.
9.

Label the vertical dimension with the Y parameter and the horizontal one with the X parameter (see the right side
of Figure 4.6).

10. Finish the extrusion and then open the “Family Types” dialog and flex.

You should be able to input values for any of the four parameters. If you make the width and depth different, you
will get an ellipse. Make them the same to get a circle.
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CATCH UP! You can open a file completed to this point named: 04_Ellipse.rfa.

CENTER MARK VISIBLE
For curved objects like circles and ellipses you can display the center mark. This can be helpful to ensure that the
element flexes in the way you expect and intend. Any curved object has this setting including arcs. For ellipses, you
can also display the foci. To display either, look for the checkbox on the Properties palette (see Figure 4.7).

FIGURE 4.7

Enable the Center Mark or Focus Marks for Circles and Ellipses on the Properties palette

We'll look at some examples in the next topic.

AUTOMATIC SKETCH DIMENSIONS
You may have noticed that when you flex Revit families certain parts may be constrained automatically. Sometimes
it behaves exactly as you want and expect, but not always. Revit does not always automatically constrain the points
you expect. So how do you determine what automatic constraints are applied? The answer is “Automatic Sketch
Dimensions.” Automatic Sketch Dimensions can be made visible in the Visibility/Graphics Overrides dialog. Use
the VG shortcut to open the dialog just like you would in a project. Once there, the Automatic Sketch Dimensions
are a sub-component of Dimensions.

ENABLE CENTER MARK
1.

Open the file: 04_Circle.rfa.

2.

Tile the windows and then save the file as: Circle (Sketch Dims).

3.

Open the “Family Types” dialog. Clear the formulas and then click OK.

This means that the width and depth parameters are no longer linked together.
4.

Make the Ref. Level Floor Plan active.

5.

Select the extrusion onscreen and then on the ribbon, click the Edit Extrusion button.



Select the circle onscreen. On the Properties palette, check Center Mark Visible (shown above in Figure 4.7).



Deselect the circle, but do not finish the extrusion yet.

ENABLE AUTOMATIC SKETCH DIMENSIONS
6.

On the View tab, click the Visibility/Graphics button (or type

VG).



Click the Annotation Categories tab.



Beneath the Dimensions category, check the Automatic Sketch Dimensions checkbox and then click OK (see Figure 4.8).
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FIGURE 4.8

Enable the display of Automatic Sketch Dimensions

Notice the two blue dimensions near the center of the circle. These are the Automatic Sketch Dimensions and by
default have associated the center of the circle to the intersection of the two reference planes at the origin of this
family (see Figure 4.9).

FIGURE 4.9

Automatic Sketch Dimensions display in a blue color
7.

Return to the “Family Types” dialog and flex the Width and Depth parameters.
As noted above, without the formulas, these two flex independently.

8.

Flex the radius (R) parameter.
Notice that the circle stays centered on the reference planes.

9.

Click OK to dismiss the “Family Types” dialog.

Revit is always looking to establish logical relationships in your families. It does this by placing Automatic Sketch
Dimensions in logical locations. In this case, Revit assumed we wanted to keep the center of the circle aligned to
the reference planes at the origin (maintain a zero distance in each direction). This may seem pretty logical. For a
circle, there aren’t too many other logical assumptions to make, so constraining the center is a good bet. However,
this simple example does not tell the whole story. Automatic Sketch Dimensions are not identical to constraints.
They will adjust on-the-fly as you edit your family. Let’s try another example.
10. Drag the circle down about 0.500 units (it does not have to be exact, but if you drag more than .5, the Automatic
Sketch Dimension will shift).

Notice that the vertical Automatic Sketch Dimension no longer reads zero, but now displays .5 or whatever amount
you dragged it. If you flex now, it will keep the center of the circle offset from the reference planes by this amount.
Again, this may be your intent and may seem logical, but in some cases it may not be what you wanted.
11. On the ribbon, click the Finish Edit Mode button.
12. Close the family without saving changes.
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Let’s return to our Ellipse family and see another example.
13. Open the file named: 04_Ellipse (Sketch Dims).rfa and tile the windows.
14. Open the “Family Types” dialog.
Note that the formulas here have already been removed.
15. Flex the Width and Depth parameters.

Notice that this time, the object does not stay centered. Let’s edit the extrusion and take a look at the Automatic
Sketch Dimensions. They have already been turned on in this file.
16. Select the extrusion onscreen and then on the ribbon, click the Edit Extrusion button.

Notice that the Automatic Sketch Dimensions are attached to the left side horizontally and to the center vertically.
Logical? Perhaps; perhaps not. The point is, that if you do not like the assumptions that Revit makes with the
Automatic Sketch Dimensions, you cannot edit them directly. Instead you have to add your own constraints and
dimensions to make your intent known to Revit. As soon as you add a dimension or constraint of your own, the
Automatic Sketch Dimension will be removed. You cannot simply delete them. You must add your own constraints
or parameters to override (and therefore make unnecessary) the automatic behavior.
17. Select the ellipse onscreen. On the Properties palette, check Center Mark Visible (shown above in Figure 4.7).
18. Using the Align tool, align and lock the Center Mark to the Center (Left/Right) and Center (Front/Back) reference planes.

Notice that as soon as you lock the alignment, the Automatic Sketch Dimension disappears. The same is true if you
add your own permanent dimension; even if you don’t lock it. Any dimension, constraint or parameter will have a
higher priority than the corresponding Automatic Sketch Dimension and as a consequence will disable it.
19. Flex the ellipse after aligning and locking and note that it now flexes around the intersection at the origin.
20. Finish the Edit Mode, and close the Ellipse file. You do not need to save.

Automatic Sketch Dimensions are an important factor in being successful in the Family Editor. If you are unaware
of them, it can make your work in the Family Editor frustrating as you make guesses on how to force Revit to
behave the way that you need. There are a few schools of thought on the use of Automatic Sketch Dimensions. The
first is to have the goal of eliminating them in all families. To do this, you would need to add your own constraints
and parameters at all locations where Automatic Sketch Dimensions appear. This can be easy to accomplish in
simple families, but in more complex ones, it can become quite difficult to achieve. So an alternate approach is to
replace only those Automatic Sketch Dimensions that run counter to your design intent. In other words, if the
family is flexing properly with the Automatic Sketch Dimensions, you can leave them alone. It is really up to you.
TIP: In general, I prefer to eliminate the Automatic Sketch Dimensions where possible, but try not to become
consumed by the task. If Revit insists on applying some Automatic Dimensions and they are not preventing my
family from flexing properly, then I leave them alone. Your results may vary.
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Note: As you work in the Family Editor, you may find yourself enabling and disabling the display of Automatic Sketch
Dimensions frequently. While tempting to leave them on all the time, sometimes they get in the way, so you’ll
want to turn them on and off as needed. However, going in and out of Visibility/Graphics can get tedious. If you
are familiar with the Revit API, you can use a macro to toggle the display of the Automatic Sketch Dimensions.
There is a terrific blog devoted to the Revit API complete with many code snippets for you to try. It is called
Boost Your BIM (Mattison 2013).
Here are some links to the code and instructions on how to make a macro from it to toggle the Automatic Sketch
Dimensions:

http://goo.gl/65XH1I
http://goo.gl/rgF5gP
http://goo.gl/hsbfi7

QUARTER ROUND AND HALF ROUND (ASTRAGAL AND TORUS)
If you have successfully constrained, parameterized and flexed a circle or ellipse, you might next want to do the same
for an arc. Arcs can be very similar to circles, but they do introduce an additional wrinkle; they have endpoints. If
your center remains at a fixed location, arcs are pretty easy to control. If the center moves, you have the additional
challenge of parameterizing the movement of the center. Let’s consider the case where the center is fixed first.

LOCKING ENDPOINTS
1.

From the Seed Families folder, open the file: Family Seed (Sketch Dims).rfa.

2.

Tile the windows and then save the file to the Chapter04 folder as: Arc (Centered).

This file is a copy of the seed families created in the previous chapter. It has the all of the starting parameters and
has Automatic Sketch Dimensions enabled. There are no formulas in Family Types.
To keep this example quick and easy, we’ll build a model line. This way we can focus on just the arc instead of
creating an entire form.
Work in the Ref. Level plan view.
3.

Delete the extrusion.

4.

On the Create tab, click the Model Line tool.



On the Draw panel, click the Center-ends Arc tool.

5.

For the center, click at the intersection of the Center (Left/Right) and Center (Front/Back) Reference planes.



Snap the first endpoint to the intersection of the Center (Front/Back) and Right Reference planes.



Snap the other point to the intersection of the Center (Left/Right) and the Back Reference planes.

Two lock icons will appear. Do not close them (see Figure 4.10).
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FIGURE 4.10

Create a Model Line arc centered on the reference planes

Notice all of the Automatic Sketch Dimension that appear. As noted above, the Automatic Sketch Dimensions try
to anticipate how you intend to flex the object. They take into account the kind of geometry that you have. So in
this case, since we have an arc, Revit is assuming we want to constrain the center point.
The more dimensions and constraints that you apply, the fewer automatic dimensions will be required. Of course
there is a fine line we walk here. If you are not careful, it is easy to get the dreaded “this would over constrain the
sketch” error.
6.

Add a radius dimension to the arc.

This removes one of the Automatic Sketch Dimensions. Let’s add a parameter to the radius so we can flex the size
of the curve.
7.

Select the radius dimension and label it with the existing Depth parameter (see the left side of Figure 4.11).

Notice how the center remains fixed as the arc’s radius increases. Revit tends to favor the center point location.
8.

Delete the arc and then add it again. This time, close the lock icons.

9.

Add the radius dimension and again label it with the Depth parameter (see the right side of Figure 4.11).

Notice that this time, since we applied the locks, the center ends up moving when you flex it. Chances are, the first
behavior was a little more expected than the second one. But both had their issues.
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FIGURE 4.11

Relying on automatic dimensions vs. applying locks

I tend not to use the locks that Revit displays when drawing a shape. I use the Align tool instead to be more precise
about where and what I am locking. With the Align tool, I see each lock being applied one at a time. I find this
much more predictable then relying on the assumptions that Revit makes and offers.
10. Delete the arc and then add it one more time. Do not close the lock icons.
11. On the Modify tab, click the Align tool.


For the reference for alignment, click the back reference plane.



For the entity to align, click the endpoint of the arc. Lock it (see Figure 4.12).

FIGURE 4.12

Align and lock endpoints
12. Repeat on the Center (Left/Right) reference plane and the same endpoint and again in both directions for the
other endpoint. (This will be four alignments total).

Notice that as you finish aligning in all four directions, all of the Automatic Sketch Dimensions will disappear. The
endpoints of the arc will now remain at the intersections of the reference planes.
13. Add the radius and label it with the Depth once again.

Were the results as you expected? This time, the center point moved. Considering that we just locked the endpoints
to the intersections of the reference planes, there is really nothing else that could flex. I suspect however, that this
may not be what you expected. It is likely that we would want the center to stay at the intersection of the two central
reference planes and instead for the width and depth to flex. We can achieve this with a simple formula as we did
in the last chapter.
14. Undo the application of the label to the radius, but keep the radius dimension.
15. Label it with a new instance parameter instead and call it: R.
16. Open the “Family Types” dialog and add a formula to both Width and Depth: R * 2.
17. Flex the family.
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Notice that now when you flex the radius, it stays confined to the upper right quadrant defined by the reference
planes. So depending on the specific behavior you require, the precise approach you use is a matter of preference.
You can also try dragging the arc’s endpoints to produce a different angle. 90° increments should be very stable. But
even other angles should work well since the main controlling parameter here is the radius. To add even more
stability, turn on the center mark (see above) and then align and lock the center in both directions to the reference
planes. With both center and endpoints locked, you don’t actually need the radius dimension. The width and depth
and flex the arc and the alignments will be maintained. Feel free to experiment further before continuing.
You can use the previous techniques to create an astragal, a torus, quarter-round and half-round shapes. You can
also use the half-round shape to create Roman arches.
CATCH UP! You can open a file completed to this point named: 04_Arc (Centered).rfa.

CONTROLLING ROTATION
While not directly related to curves, controlling rotation in a family reliably is another important skill. Many families
require rotational parameters. Reference planes do not rotate reliably. To add an angular parameter to a family, you
need to use a reference line instead of a reference plane. Even though reference planes appear on screen to have a
start and end point, they are really infinite. This makes it difficult to use them to control rotation in a family. A
reference line on the other hand has a finite length and both a start and end point. You can assign angle parameters
to them. Also, reference lines have built-in work planes, so you can also use them to control the rotation of other
elements within a family. A very common application for this is to control the swing of a door. However, we can
also use this technique in conjunction with the previous lesson to control the angle of a variable arc at both its start
and end points.
In order to use a reference line to control a rotation parameter effectively, you need to establish two things: first,
you must constrain the end of the reference line that you wish to be the point of rotation. If you do not, the rotation
parameter will behave unpredictably. Second, you must set one of the work planes of the reference line current and
then add your solid geometry to this plane. Alternatively, you can lock geometry to the rotating reference lines in
some cases as well. Reference lines can be drawn in a variety of shapes. However, a simply linear reference line is the
most useful for rotational parameters.

CREATE A DOOR FAMILY WITH VARIABLE SWING
Many families can benefit from parametrically controlled rotation. But perhaps one of the most common is a door
with variable swing. The following steps show a simple example.
1.

From the Application menu (big “R”), or on the Recent Files screen, choose New > Family.

2.

Select the template named: Door.rft and then click Open.
A copy of this file is provided in the Template/OTB folder with the book’s dataset files.

3.

Save the file as: Door w Variable Swing.

CREATE AND CONSTRAIN A REFERENCE LINE
In this tutorial, we will create an angular parameter and associate it to a reference line for purposes of defining a
variable door swing parameter in the door family. The trick to making the reference line work properly is being sure
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that you apply the constraints and parameters to it very carefully. In the Family Editor, it is sometimes easier to do
this if you hide some of the geometry.
1.

Select the Wall and on the View Control Bar, from the Temporary Hide/Isolate pop-up, choose Hide Element.

2.

Repeat for the Frame/Mullion component.

There are three horizontal reference planes remaining on screen where the wall was. One is at the center and one
each for the two edges of the wall. These two are named: Exterior and Interior. This is a standard feature of the
Door.rft template (see Figure 4.13).

FIGURE 4.13

Reference planes are included at the faces of the wall

We need to decide where we want the door’s hinge point to be. If you want the hinge to always be at the face of the
wall, we can use one of these two reference planes. Otherwise, you would want to create a new reference plane for
the hinge.
The point of considering this issue is to realize that there can be much deliberation that goes into the creation of
any family. For simplicity’s sake and to focus on the rotation parameter, we will use the Exterior reference plane for
our hinge point in this exercise. Once you understand the procedure outlined here, you can take the technique and
apply it differently in your own families.
The basic process required is as follows: draw a reference line, lock one endpoint to the intersection of two reference
planes (this is the location of the hinge point). Then assign a rotation parameter to the reference line. The easiest
way to do this is to draw the reference line at an angle first.
1.

Draw a 45° reference line starting at the intersection of Left and Exterior reference planes. Make it 3'-0" long
(see Figure 4.14).
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FIGURE 4.14

Draw a reference line from the hinge point at 45°

The order that you click the two points determines the direction of the face normal of the work planes (see Figure 4.15).

FIGURE 4.15

The normal direction (positive direction) of the faces of the reference line is determined by the direction you draw it
2.

Select the reference line. On the temporary dimension that appears, click the small icon to make the temporary
dimension permanent.

Adjust the position of the dimension if you like.
3.

Select the new dimension and from the Options Bar, label this with the existing Width Parameter.

4.

Use the Align tool and the
(see Figure 4.16).

5.

Repeat on the Ref Plane: Exterior.

TAB

key technique to align and lock the end of the reference line to the Ref Plane: Left

FIGURE 4.16

Align reference lines to lock them to the reference planes
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This step is important. By locking the end point (hinge point) of the reference line in both the horizontal and
vertical directions we ensure that the hinge point of the Door will move with the Door as expected. Having applied
the Width parameter above further ensures that the reference line will flex as expected with the rest of the Door.
6.

Flex the model. Modify the Width and then set it back to 3'-0" before closing the “Family Types” dialog.

ADD A SWING PARAMETER
The final step is create the rotation parameter.
1.

On the Modify tab, on the Measure panel, click the drop-down on the dimension too and choose Angular Dimension.

2.

Click on the Reference Plane:Exterior first and then click the reference line.

3.

Place the Dimension (See Figure 4.17). Cancel the command.

FIGURE 4.17

Create an angular dimension between the Exterior reference plane and the reference line
4.

Select the angular dimension and then on the Options Bar, from the Label drop-down, choose <Add parameter>.

5.

Name the parameter Door Swing, group it under Graphics, make it an Instance parameter and then click OK.

Group Under can be anything. We chose Graphics here, but if you prefer another grouping it will not affect its
behavior at all. It is a matter of personal preference and/or office standard. Likewise, this parameter will function
equally well as either a Type or Instance parameter. You can decide which will serve your needs best.
6.

Flex the Model. Try different Widths and different Swing angles.

7.

When satisfied that everything works properly, reset the Width to 3'-0" and the Door Swing to 45°.

CATCH UP! You can open a file completed to this point named: 04_Door w Variable Swing.rfa.

The main focus of this chapter is on techniques to control curvature in families. Therefore, we will just give a brief
summary of the steps to follow next to create the solid geometry required for a door panel. This should give you the
basics you need to complete the door family if you wish. Otherwise, the technique outlined above can be used to
control rotation of nearly any element. (We will also create a more complete door later on in the “Combining
Strategies” topic below).
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CREATE THE DOOR PANEL GEOMETRY
To draw door geometry and constrain it to the reference lines is simple. The reference line has four integral Work
Planes (see Figure 4.18). There is one horizontal, one vertical and one at each end point. You simply click the Set
Work Plane tool, choose the “Pick a Plane” option and then select the plane upon which you wish to draw. It is
recommended that you leave the reference line oriented at 45° for this. Cut a section at 45° as well, parallel to the
reference line. Then open this view to work. If you work in one of the orthographic views, you can accidentally
constrain your geometry to other nearby Ref Planes and geometry making it difficult to later flex the model. If you
build your door panel extrusion on the 45° you can easily avoid this. Another technique often employed is to nest
in another family for the door panel. The choice is a matter of personal preference and/or office standards.

FIGURE 4.18

Reference lines have four integral Work Planes

Create the section, open it and then set the vertical work plane of the reference line current. Draw a solid extrusion
on this plane. Snap it to the ends of the reference line. Use the Thickness parameter for the extrusion end property.
To create a 2D plan version, draw Symbolic Lines using the pick lines option and constrain them to the edges of
the solid extrusion.

ROTATING A CURVE
Combining the techniques covered in the two previous topics, we can create a parametrically controlled arc that
allows us to set a start angle and an end angle. The basic process involves creating two parametrically rotating
reference lines and then constraining the arc between them.

BUILD THE REFERENCE LINES AND PARAMETERS
1.

From the Seed Families folder, open the file: Family Seed (Sketch Dims).rfa.

2.

Tile the windows and then save the file to the Chapter04 folder as: Rotating Arc (Centered).

3.

Delete the extrusion onscreen.

4.

Following the procedure in the “Controlling Rotation” topic above, create a 45° reference line starting at the two
center reference planes and make it 2.000 units long.

5.

Make the temporary dimension permanent and label it with the Depth parameter.

6.

Align and lock the endpoint at the center.

7.

Add an angular dimension and label it with a new instance parameter named A.

8.

Repeat the procedure creating a second reference line at 135° (see Figure 4.19).
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FIGURE 4.19

Create two reference lines constrained at the center with length and angle parameters

Be sure to perform all of the steps before flexing. Then flex everything and make sure it is working. For the geometry,
we can make a Model Line again, or build an extrusion, or even create a curved path for a sweep.
CATCH UP! You can open a file completed to this point named: 04_Rotating Arc (Centered).rfa.

CREATE GEOMETRY ON THE ROTATING CURVE
Whichever type of geometry you decide to build, the process is similar. Make sure that the arc is centered on the
reference planes (at the rotation points of the reference lines). Turn on the center marks, align and lock in both
directions. Constrain the radius using the existing Depth parameter. Lock the endpoints of the arc to the reference
lines (see Figure 4.20).

FIGURE 4.20

A variety of forms can be built on this armature such as extrusions or sweeps

You can construct any form this way. I made a pie slice with an extrusion and a simple curved sweep in the figure.
But you could experiment with other forms if you like.
CATCH UP! You can open files completed to this point named: 04_Rotating Arc (Extrusion).rfa and
04_Rotating Arc (Sweep).rfa
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ARCHES
The previous examples all had the center point located at and constrained to two reference planes. But what do you
do when the center of your arc does not land on such a convenient location? This is the case for many types of
arches (see Figure 4.21) (Realtor 2001). Look around the town you live and you are bound to find many different
types of arches used in the buildings; and not just the classical ones, but you will see plenty of arches on those as
well.

FIGURE 4.21

A selection of arches

CREATE A PARAMETRIC SEGMENTAL ARCH
We could do an entire chapter or maybe several on the subject of arches alone. I won’t have time and space to do
all of them, but let’s consider a few common shapes. Starting with a Roman arch. To build a Roman arch you can
simple use the techniques covered above. A Roman arch is a semicircle, so the techniques discussed above will work
well. Just turn on the center mark, align and lock it to reference planes and then lock the endpoints of your arc on
both sides as well. You can flex its shape with standard width and depth parameters (although you might want to
think of the depth as height in the case of an arch) and add a radius parameter if desired.
If you have one of the other forms, you might have a tougher time making the arch behave as it flexes. For example,
let’s consider a Segmental arch. This one has an eyebrow shape and as its name implies is a segment of a circle. The
main issue with such an arch is that the center point moves as the arch flexes. So since the techniques above relied
on locking the center point, they will not yield good results. Let’s look at what must be done to make a segmental
arch behave. Here we must break our rule about keeping constraints applied only to references again. The key to
success is applying the labeled dimension directly to the geometry of the curve (like the circle and ellipse above)
rather than the traditional approach of dimensioning the reference planes and then letting them flex the geometry.
(I should note that it is possible to stay true to the traditional approach and dimension only references. It would
require formulas to calculate where the references need to be to give the correct curve. We will see examples of this
below).
One last preliminary point. Back in the “Face-Based or Free-Standing” topic in Chapter 2, we discussed the face
based family template and create a face based seed family. I think that in many cases, you will find a face based
template a good choice for an arch. This makes it easy to place them on or in existing walls. You can of course use
your free-standing template instead. All of the steps that follow should work fine in either one. But I have chosen
our face based seed here.
1.

From the Application menu, choose Open > Family.

2.

Browse to the Seed Families folder, select the file named: Family Seed (Face Based).rfa and then click Open.
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Type WT and then ZA.

3.

Save the file in the Chatper04 folder as: Segmental Arch.

Our seed families all have the two default reference planes at the center. In this case, let’s use the Center (Front/Back)
reference plane (the horizontal one in the middle) as the spring line of the arch, so we’ll need to delete the
bottommost one.
4.

Delete bottom reference plane. Also delete the extrusion.

When you do this, you will be left with a single unlabeled vertical dimension.
5.

Select the vertical dimension.



On the Options Bar, label it with a new instance parameter and call it: Rise.

6.

Select the top reference plane and on the Properties palette, rename it to Arch Top.

7.

Flex the family to ensure everything is working. Set the Rise to: 0.750 (see Figure 4.22).

FIGURE 4.22

A selection of arches

With this framework in place, we are ready to build our geometry. While it is possible to use an extrusion here, it
takes a little more effort to constrain it. This is because an extrusion would require two parallel curves. Instead, let’s
create a sweep. It is the path of the sweep that will form the arch shape.
8.

On the Create tab, click the Sweep button. Choose the Sketch Path option on the ribbon.

9.

From the Draw panel, choose the Start-End-Radius arc.

10. Snap the start and end points to the intersections where the left and right reference planes cross the Center
(Front/Back) reference plane (see points 1 and 2 in Figure 4.23).

FIGURE 4.23

Create the path of the sweep with a start-end-radius arc
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Snap to the intersection of the Top and Center (Left/Right) reference planes for the radius (see point 3 in Figure 4.23).

11. Using the Align tool, align and lock the start and end points of the arc to the reference planes in both directions
(see Figure 4.24).

FIGURE 4.24

Align and lock the endpoints of the arc to the reference planes in both directions

Aligning and locking works fine for the endpoints. Unfortunately we cannot align and lock the midpoint of the arc.
But just the same we always want the midpoint of the arc to stay with the top reference plane. To do this, we’ll
dimension the sketch line directly.
12. Create an aligned dimension. For the first witness line, click the Center (Front/Back) reference plane.


Click directly on the arc next to add the second witness line (see Figure 4.25).

FIGURE 4.25

Dimension the arc directly
13. Label this dimension with the existing Rise parameter.


Flex the family.

That’s it! The arch can now have nearly any rise value you like to create segmental arches of various shapes and
proportions. If the value of Rise is equal to half of the Width parameter, you will get a Roman arch. If you go larger
than this it will make an arch that has a Moorish shape. An arc must be curved, so you cannot use a value of zero.
Therefore, to make a jack arch simply make a separate family with a rectangular form.
To complete the arch, just edit the sketch for the sweep profile and create a simple rectangle. If you prefer, you can
use a more complex shape, but a rectangle will do the trick for now (see Figure 4.26). We’ll do a more complex arch
toward the end of the chapter.

FIGURE 4.26

Complete the arch family and load it into a project

CATCH UP! You can open a file completed to this point named: 04_Segmental Arch.rfa.
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GOTHIC ARCH
As noted, the previous family will yield many of the common arch forms, but not all. To create some of the others,
we can leverage the same basic concepts. For example, a gothic shaped arch can be achieved by taking two segmental
arch rigs and placing them in a triangular construct. I won’t detail all of the steps here, but instead simply describe
the overall process (see Figure 4.27).

FIGURE 4.27

A gothic arch can be formed using essentially two segmental arches

Start with the same seed family and set it up the same way. You can even save the Segmental Arch family as a new
name and just delete the sweep. Usually a gothic arch will have a higher rise, so flex the rise parameter to at least the
same value as Width (shown as W in the figure). Draw two reference lines (not reference planes) forming a triangle.
This will form the spring lines of each side of the arch. Use the Align tool to align and lock the endpoints of the
reference lines to the intersections of the reference planes. Make sure you align and lock all four endpoints in both
directions (eight total). It is a good idea to flex at this stage.
Note: Sometimes when aligning and locking, Revit will complain that locking will over constrain the sketch. If you
see this message, just click Cancel. No need to pursue it further as this message should be indicating that no
further constraints are necessary at the location. Remember that having Automatic Sketch Dimensions
displayed during this task can be very helpful in determining if you need to continue aligning and locking.

Begin your sweep and choose the Sketch Path option. Draw two Start-End-Radius arcs. The endpoints should snap
to the ends of the reference lines. The radius can be anything, but they should be the same for both arcs. You can
begin eyeballing the curve, and before clicking, type in a whole number value based on the temporary dimension
displayed. This makes it easy to get the same radius on both sides. I used a value of 3 in the figure. Align and lock
the endpoints of the curves to the reference planes.
Create a new dimension between the reference line and the rise of each arch. Make sure to set the first witness line
at the reference line, then click the curve. Label each of these with a new parameter called: Seg Rise. Flex and
then Finish the path.
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Finally, sketch the profile. You can also load in a profile family for the profile if you prefer. (We will explore profiles
below). Flex the completed form. Be careful in flexing as certain combinations of Rise, Seg Rise and Width will
cause it to fail, but it should work well for many combinations.
CATCH UP! You can open a file completed to this point named: 04_Gothic Arch.rfa.

ELLIPTICAL ARCHES
If you would rather use an ellipse to form the path of your sweep, much of the process remains unchanged. You
draw the ellipse using the partial ellipse shape on the Draw Panel, align and lock its endpoints just like the arc.
However, when you try to dimension the elliptical arc, Revit will stubbornly refuse to highlight it like it did for the
arc. So instead of placing the dimension with the Aligned Dimension tool, the trick is to first select the partial ellipse
onscreen, then click the small “Make this temporary dimension permanent” icon. This will make the dimension for
you and then you can label it. All else will work the same way (see Figure 4.28).

FIGURE 4.28

Make the temporary dimension permanent to create a flexible elliptical arch

All of the steps from the previous few examples are the same. Set up the same reference planes and parameters, or
start with your segmental arch and save as. For the path of the sweep, draw a partial ellipse. Lock the endpoints and
then select the elliptical arc and make the temporary dimension permanent as shown in the figure. Sketch the profile
as a simple rectangle like the others and then flex it when finished.
CATCH UP! You can open a file completed to this point named: 04_Elliptical Arch.rfa.

COMPOUND CURVES
All of the examples so far have been single curves; in other words, there has only been one curve that we were trying
to flex. In such cases, if you ensure that you constrain and/or parameterize the key geometric aspects of the curve,
you will usually get good results. For example, with a circle or arc, if you constrain the center and radius, it will
usually flex properly. With an ellipse, the center and axes usually give good results. However, as the forms that you
wish to flex become more complex in shape, sometimes even constraining the center and radius will not be enough.
Consider situations where there is more than one arc segment making up a compound curve. Or even situations
with a curve meeting a straight line at a tangent. There are endless possible examples. In this topic we’ll consider a
few of the more common examples. In similar fashion to the examples above, the key is going to be carefully
constraining the curves so that you remove any ambiguity. You want to make it very clear to Revit what your
intentions are. If you do this, everything should flex properly.
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PROFILE FAMILIES
In the “Profile Families” topic in Chapter 2, we discussed profile families and applied some examples to simple
sweep and swept blend forms. Several advantages of profile families were discussed in that topic. Perhaps the most
important benefit of profile families is that we can use them in several forms and families. For the task of creating
complex flexible curved forms, it is much easier to build a profile family and get the shape flexing properly, and
then apply it to any 3D forms required. The remaining examples will use profile families.
Some challenges do exist. Profile families can contain reference planes, but not reference lines. Since we discussed
the importance of using reference lines above when making a family that requires parametric rotation, this presents
us with a bit of challenge.
There are some acceptable solutions. For example, you can use trigonometry to derive X and Y coordinates from
any angle. This is very effective and very stable, however, trig can be challenging and introducing many formulas
can have a detrimental effect on overall performance. Another solution that we will explore is using a nested rig
family. Nesting can also be detrimental to performance, so you will have to consider each use case carefully. We’ll
see several examples below.

OVOLO
Let’s start with some common molding shapes. I have previously cited the excellent book on classical architecture:
The Classical Orders of Architecture (Chitham 1985, 2005). In Plate 76, Chitham details the construction of many
common moldings. In Figure 4.29 I have reproduced the first two moldings we will consider: the ovolo and cavetto.
Both use a single curve, but constructing them introduces a challenge (an offset center point) that once solved, will
help us create the more complex compound curves that follow.

FIGURE 4.29

Constructing Ovolo and Cavetto profiles

Consider the shapes shown in Figure 4.29. The left side comes from Chitham and shows how to construct the
curves using traditional drafting tools. The most likely way to describe the size of a molding like this and therefore
the most likely way to flex this curve would be to ask for the depth and the height of the curved portion of the
molding. This is shown on the right side. As you can see in the image, this width and depth of the curve portion
are normally not equal, (A quick trip to your local lumber yard will allow you to verify this) meaning that the
construction axes are along angled paths and as the dimensions flex. This also means that the center point is not
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always in the same location. As we mentioned above, reference lines are the best choice for controlling angles in
families. However, reference lines are not available in profile families, so we could abandon our use of profiles and
resort to building each molding with its own integral sketch. This would not be ideal since we would lose all benefits
of using profile families. One of the most important being that they can be reused in multiple families. Therefore,
if we can define them once in a good flexible profile family, we can then reuse them in almost unlimited ways in
other content. So to build it as a profile family, we will have to resort to other techniques to control the shape of
this family and ensure that it flexes properly.

USING TRIGONOMETRY TO MODEL TRADITIONAL MOLDING FORMS
As noted at the start of this topic, there are two viable options here. In the examples that follow, we’ll look at both.
Let’s start with trigonometry. Depending on the complexity, the trig might be simple or complex. In this case, we
have a simple case of similar triangles. You will be asking your user to input the desired height and depth of the
molding. We will call these X and Y in the profile family. When you make a triangle from X and Y, you can easily
derive the hypotenuse which we will call D (for Diagonal). Using trig, and these values, we can easily derive one of
the angles which we will call A. Since we know all three sides, we have lots of options to choose from (Munkholm
2011) (also see Appendix A). For this example I went with the ATAN function performed on X and Y: ATAN(Y/X)
to arrive at A. This new angle, coupled with half of D (we’ll call this HD) can be applied to the second triangle.
Finally with this information, the COS function will give us the length of the radius: HD / COS(A) (see Figure 4.30).

FIGURE 4.30

Applying trigonometry to locate the required reference planes

Provided with the dataset is a seed file for a profile family. It has the two default center reference planes positioned
at the lower left corner. Two additional reference planes named: X Mid and X Max, and Y Mid and Y Max are
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placed above and to the right of these. They are dimensioned and constrained already. To this framework, we need
to add a vertical reference plane to left for the radius location indicated in the figure. Our formulas will help us
locate it.
1.

From the Application menu, choose Open > Family.



Browse to the Seed Families folder, select the file named: Family Seed (Profile).rfa and then click Open.



Save the file in the Chatper04 folder as: Ovolo Profile.

2.

To the left of the Center (Left/Right) reference plane, draw a vertical reference plane. Name it Radius.



Add a dimension between the X Max reference plane and Radius.



Dimension and Label it with a new Type parameter called R.

3.

Open the “Family Types” dialog.

4.

Using the Add button on the right, create two new Type-based Length parameters: D and HD. Also create one
Type-based Angle parameter called A.
Group all of these under Constraints.

5.

Input the formulas as follows (see Table 4.1):

TABLE 4.1

Parameter

Formula

D

sqrt((X ^ 2) + (Y ^ 2))

HD

D/2

A

atan(Y / X)

R

HD / cos(A)
6.

Flex the family by creating a few Family Types (see Figure 4.31).

FIGURE 4.31

Create the parameters and Family Types

There is a simple triangle in this family already just to facilitate flexing. We can now delete this and draw the actual
profile shape that we need.
7.

Delete the triangle onscreen.

CATCH UP! You can open a file completed to this point named: 04_Ovolo Profile (Ref Planes).rfa.
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8.

On the Create tab, click the Line tool.

9.

For the right side, draw a Center-ends arc with the center at the intersection of the Y Max and Radius reference planes.
Be sure to turn on the center mark, align and lock the center in both directions as well as the endpoints.

10. Draw vertical and horizontal lines locked to the reference planes for the leftmost edge and the top and bottom
(see Figure 4.32).

FIGURE 4.32

Create the profile lines

CATCH UP! You can open a file completed to this point named: 04_Ovolo Profile.rfa.
11. Flex the completed version when done.

You can load this profile into any project or family now and use it shape anything from sweeps, to wall profiles to
railings. A simple family file is provided here to test it out.
12. From the Chapter04 folder, open 04_Ovolo Sweep Flex.rfa.

A version of the profile family is already loaded, but if you prefer, you can load your version instead.
13. Select the sweep and edit it. On the ribbon, click the Select Profile button and then from the drop-down list,
choose one of the types you previously defined.
14. Finish the sweep and flex the family (see Figure 4.33).
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FIGURE 4.33

Apply the profile to the sweep form

This “flex” file that we have open is like a sandbox file. We are using it just to test out the profile and ensure that it
works as expected. The family has two simple parameters: W and D. If you flex them, you will see the shape of the
sweep path adjust. You can see by doing this how your profile follows along both straight and curved path edges. If
you want to change the profile, edit the sweep again and pick a different type from the list. Using the technique we
explored in the “Associate Family Parameters” topic in Chapter 3, we can even edit the type of the nested profile
family and link up the X and Y parameters with driving parameters here in the host family. I will not go into the
steps at this time, but feel free to experiment with this if you like.
15. Close both family files.

USING A NESTED RIG TO MODEL TRADITIONAL MOLDING FORMS
The previous example used formulas and trigonometry to locate the shifting center point of the curve. This allows
us to have just two user inputs: X and Y and let the curve adjust to those inputs. For various reasons, you may wish
to avoid formulas. Some folks find them cumbersome and complex. They also can impact performance if there are
many of them in use. An alternative is available to formulas. We can build a separate “rig” family and then nest it
into our profile family. This will help us overcome the limitation of not having reference lines to control rotation.

CAVETTO
In this example, we will look at the cavetto curve. It is exactly the same construction as the ovolo with the curve
reversed. So the radius reference plane needs to be on the right with the center of the curve at the intersection of the
radius and Center (Front/Back) reference planes. In all other ways, we could use the same strategy and formulas.
But in this example, we’ll look at an alternative: using a “rig” on which to build the curve form.
The starting family in this case uses the same seed we used for the ovolo profile above. It has one extra reference
plane to control the depth of the form.
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1.

From the Chapter04 folder, open the file: 04_Cavetto Profile (Rig)_Start.rfa.

2.

Save the file as: Cavetto Profile.

We’ll also need our rig family. This one is a Detail Item family. We cannot use reference lines in Profile families.
And while we can use reference planes, as we noted above, they do not work well in controlling angles. So instead
of reference lines, we will simply draw lines instead. However, if we draw the lines directly in the profile family,
they will be seen by Revit as part of the profile. If we instead draw our guide lines in a Detail Item family they can
be used for our framework or “rig” and not be seen as part of the profile.
3.

From the Seed Families folder, open the file named: Family Seed (Detail).rfa.

4.

Save the file in the Chapter04 folder as: Single Curve Rig.

This seed was created from the Detail Item.rte template. Reference planes were added and a few dimensions and
parameters to save time. (The original Detail Item.rte template is provided in the Templates/OTB folder).
5.

On the Create tab, click the Line tool. Snap the first point to the intersection of the Left and Front reference
planes and the second point to the Right and Back reference planes.



Align and lock the endpoints to the reference planes in both directions on each end.



Flex to be sure it adjusts with the width and depth.

6.

Draw a second line starting at the midpoint of and perpendicular to the first line. Make it approximately the same
length as the other one.



Select the line and then click the small “Make this temporary dimension permanent” icon for both the length
and angle dimensions (see the left side of Figure 4.34).

7.

Select the new linear dimension and label it with the parameter called P (already in the file).



Lock the angle dimension (see the right side of Figure 4.34).

FIGURE 4.34

Build the rig in a Detail Item family

Optionally you can open Object Styles and create a new subcategory. Call it Guide Lines and then set the color to
a light blue. This will help the rig stand out when nested into other families.
8.

Save the family.

CATCH UP! You can open a file completed to this point named: 04_Single Curve Rig.rfa.
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9.

Click the Load into Project button.



Click to place it onscreen. Align and lock it on all four sides.
For each alignment, first click one of the reference planes in the host family, and then click the nested shape handle
edge in the detail item family. Use TAB if necessary to get shape handle each time (see left and middle of Figure 4.35).

FIGURE 4.35

Nest in the rig, align and lock it on all four sides
10. Flex the family.

Notice that the nested detail item family changes shape with the host family. The diagonal line stays aligned with
the flexing reference planes and the perpendicular line remains perpendicular. The intersection of the perpendicular
line and the Center (Front/Back) reference plane is the center of our curve for this profile.
11. Select detail item and on the Properties palette, uncheck the Visible checkbox (see the right side of Figure 4.35).

This makes the rig invisible in all families that use the profile; we will only see it here were it is needed.
CATCH UP! You can open a file completed to this point named: 04_Cavetto Profile (Rig)_A.rfa.
With the rig in place, we draw the lines that make the profile shape next.
12. Draw the curve as we did above for the ovolo. Use the intersection of the perpendicular line and the Center
(Front/Back) reference plane as the center.
13. Align and lock the endpoints of the curve.

Important: Pay attention to the Status line as you align. You want to align to the reference planes in the profile
family, not the references or shape handles in the nested family. Use TAB as necessary.

Notice that after you align and lock the endpoints in both directions, that all of the Automatic Sketch Dimensions
will disappear. As such, you do not have to turn on the center mark or align and lock the center. However, it is a
nice extra precaution. Furthermore, even though in most previous examples we aligned in the X and Y direction,
you can actually enable the center mark and align it horizontally to the Center (Front/Back) reference plane and
then align it again to the diagonal line in the nested family.
14. On the left, top and bottom, draw straight lines. Align and lock anywhere an Automatic Sketch Dimension
appears (see Figure 4.36).
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FIGURE 4.36

Create the profile shape and align and lock as necessary

CATCH UP! You can open a file completed to this point named: 04_Cavetto Profile (Rig).rfa.
15. Flex the family and then load it into the 04_Cavetto Sweep Flex.rfa file to test it out in a sweep.

There are pros and cons to each approach. If you get the formulas right using formulas and trigonometry is very stable. But
as noted, it can impede performance. Using the rig is a clever work around to some built-in limitations. It can be quite stable
as well, but you have to be careful about which points you align and lock and make sure you do not inadvertently create bad
references that prevent the families from flexing. You are encouraged to try both approaches and compare and contrast your
results. With these techniques in hand, let’s move on to more complex curves: the Cyma and Cyma Reversa.

CYMA
Figure 4.37 shows the way that the Cyma and Cyma Reversa profiles are constructed, a circle is created whose
diameter matches the diagonal between the X and Y (Height and Depth). This circle is intersected with two arcs of
the same radius which, when intersecting perpendiculars are drawn, creates four equal segments along the diagonal.
The points where the arcs intersect the circle are the centers for the arcs used to create the Cyma profile (Chitham
1985, 2005). Once again, we will asking our user for Width and Height inputs.

FIGURE 4.37

Constructing Cyma and Cyma Reversa profiles
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It just so happens that this construct also creates a regular hexagon whose vertices intersect the circle at the same
points. Compare the gray dashed construction arcs in Figure 4.38 with the superimposed hexagon. A regular
hexagon can be divided into six equilateral triangles. The sides of these triangles are each equal to half the length of
the diagonal (between the Height and Width). This distance (the side of the equilateral triangle) is the radius of the
arcs used for the cyma and cyma reversa profiles.

FIGURE 4.38

Applying trigonometry to locate the required Cyma reference planes

Once again, we can use trigonometry or nested detail components to construct this profile family. The trigonometric
formulas are shown in the figure and in the table below.
The basic idea is that the user input is the Height (Y) and Width (X). This is used to determine the angle of the
diagonal (D) which is in turn used to locate the center point of the two arcs of the compound curve and their radii.
We’ll start with a file based on the ovolo example above.
1.

In the Chapter04 folder, open the file: 04_Cyma Profile_Start.rfa.

2.

Save the file to the Chapter04 folder as: Cyma Profile.

Some of the work has been done here already. To create this file, a copy of the Ovolo file created above was saved.
This means that some of the reference planes and some of the formulas were already in place. This includes the
insertion point at the lower left corner, the X Mid, X Max, Y Mid and Y Max reference planes, and the parameters
X, Y, A, R and D. HD was not needed and has been removed. Additional reference planes have been added: Center
Right Ver, Center Right Hor, Center Left Ver and Center Left Hor, the parameters X1 and Y1 are applied to the
reference planes already (see Figure 4.39). There are also additional parameters listed in the table below.
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FIGURE 4.39

Starting family contains the reference planes and parameters

The formulas have not yet been added except those that came from the ovolo family. We will do this task now.
3.

Open the “Family Types” dialog. Using the following table, input the formulas shown for each parameter (see
Table 4.2).

TABLE 4.2

Parameter

Formula

Y1

R*sin(B)

X1

R*cos(B)

R

D/2

D

sqrt((X ^ 2) + (Y ^ 2))

B

120 – A

A

atan(Y / X)
4.

Click Apply to test the values.

The reference planes should adjust slightly.
5.

Try flexing with each of the types in the family already. Click OK when finished.

6.

On the Create tab click the Line tool and then click the Center-Ends arc icon.



Snap the center of the arc to the intersection of the Center Left Hor and Center Left Ver reference planes.

7.

Snap the one endpoint to the intersection of the Center (Front/Back) and Center (Left/Right) reference planes and the
other to the intersection at X Mid and Y Mid (see the small dots at locations a, b and c on the left side of Figure 4.40).
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FIGURE 4.40

Draw the curves


Select the arc and on the Properties palette, check the Center Mark Visible checkbox.



Align and lock the center point and each arc endpoint to the reference planes in both directions (6 alignments
total) (see the middle of Figure 4.40).

8.

Repeat the process by drawing a second arc with center at point e (the intersection of the Center Right Hor and
Center Right Ver reference planes) and endpoints at locations c and d.



Turn on the center mark and align and lock all points (see the right side of Figure 4.40).

9.

Open “Family Types” and flex the curve.

The curves should flex properly and remain constrained to the reference planes.
10. Draw vertical and horizontal lines locked to the reference planes for the leftmost edge and the top and bottom.

CATCH UP! You can open a file completed to this point named: 04_Cyma Profile.rfa.
11. Flex the completed version when done.

You can load this profile into any project or family now and use it shape anything from sweeps, to wall profiles to
railings. A simple family file is provided here to test it out.
12. From the Chapter04 folder, open: 04_Cyma Sweep Flex.rfa.

A version of the profile family is already loaded, but if you prefer, you can load your version instead.
13. Select the sweep and edit it. On the ribbon, click the Select Profile button and then from the drop-down list,
choose one of the types you previously defined.
14. Finish the sweep and flex the family.

CYMA REVERSA
The Cyma Reversa is essentially the same shape just with the arcs reversed. So all we need to do to create one is save
the Cyma family with a new name and redraw the arcs facing the opposite direction. However, the formulas do
need adjustment due to the changed locations of the arc center points. The overall strategy and form is largely similar
(see Figure 4.41). You can try your hand at one if you like, or you can simply open the example provided here.
CATCH UP! You can open a file completed to this point named: 04_Cyma Reversa Profile.rfa.
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FIGURE 4.41

Cyma Reversa Construction

The critical angle is angle B. There are two known angles in its vicinity, the right angle between the reference planes
X Max and Y Max and the angle between the diagonal and the top edge of the implied hexagon. The diagonal, as
we saw above, is derived from the Height (Y) and Width (X) parameter inputs and the Pythagorean Theorem. As
the diagrams in Figure 4.38 (above) and Figure 4.41 illustrate, the diagonal’s endpoints form two vertices and
becomes the bisector of an implied hexagon. The hexagon’s other four vertices determine the locations of the center
points of the arcs of Cyma and Cyma Reversa curves. Since a regular hexagon is easily divided into six equilateral
triangles, we also know that the angle between the diagonal (bisector) and the hexagon’s top edge is 60°. These
known angles make it easy to calculate angle B, which in turn gives us the values X1 and Y1 and the locations of
the required reference planes.

CYMA AND CYMA REVERSA RIGS
If you look on the Families branch in the two testing files: 04_Cyma Sweep Flex.rfa and 04_Cyma Reversa Sweep
Flex.rfa you will find two versions of the nested profile families. The ones with the (Trig) suffix use the trigonometry
formulas and the ones with (Rig) suffix use a 2D detail item family rig nested in them. Feel free to experiment with
each one and open them to explore if you wish.

PROPORTIONAL SCALING STRATEGIES
Configuring curved forms so that they can be reshaped parametrically in a predictable and stable way has been the focus
of all the examples in this chapter. The previous chapter focused entirely on proportion and scaling. But since proportional
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scaling is especially important when building classical architectural forms like Doric, Ionic or Corinthian columns, we
will now look at some examples that tie the concepts from this and the previous chapters together.
Many of the examples covered so far in this chapter have allowed for flexibility in both the X and Y directions, but
so far we have not discussed strategies to scale the X and Y dimensions proportionally. Naturally, you could just
take great care to always make sure your inputs to X and Y match the desired proportions, but of course, this
approach is hardly foolproof. With the framework we already have in place for most of the examples created so far,
it is very easy to apply an additional constraint to the parameters to force them to flex proportionally. For example,
if you like the proportion achieved when X = 4 and Y = 5, simply add a formula in “Family Types” for X that reads
Y * .8. Other formats work as well, such as Y * 5/4, or a formula for Y instead reading: X * 1.25. It doesn’t really
matter which one you use, as they will all yield the same results. This is true because as we noted in the previous
chapter, simple arithmetic formulas are bidirectional. So you can edit the value of either X or Y and the other will
update accordingly automatically.
To add another level of flexibility, albeit with a touch more complexity, you can introduce a multiplier. This will
enable you to establish the proportion of two or more parameters to one another, but also scale the entire family
based on a single multiplier value. We did the simplest form of this approach in the previous chapter when we
introduced the Base Diameter parameter. I have explored a few ways to approach this and have included a few
additional profile families in the dataset that utilize some various scaling and proportional strategies. Let’s have a
look at them now.

CORONA
A Corona is really just a variation of the Cavetto that we considered above. It has a similar curve with a long fillet
projection beneath it. I have made the projection flexible and variable. However, I have made the curve portion
proportional. In addition, I have tied everything together so that a single Base Diameter parameter can scale the
entire shape. So when flexing this family, you can choose different heights and depths for the rectangular portion,
but when you scale, the curve always maintains its proportion (5/6 of Y in this case).
SAMPLE! You can open a sample file named: 04_Corona Profile (Fixed Proportion).rfa.

Feel free to open the file, and consider Figure 4.42. Y1 and X1 drive the size of the lower rectangular portion of the
profile. Y1 and X1 are derived formulaically from user inputs to Y Projection Mult and X Projection Mult. These
two parameters are formatted as Number parameters (not Length). This means that they cannot drive lengths
directly. To make them drive the length parameters Y1 and X1, they are multiplied by a length parameter. Like the
previous chapter, I used the parameter Base Diameter for this. Depending on the use of any moldings created from
this profile, you can input appropriate values for the multipliers to yield a molding of the required size. In other
words, if you use this molding on a pedestal, you might need a longer projection or different depth than you require
when it is used on an entablature. The third numeric parameter called: XY Mult is used to control the size of both
Y and X. It is applied directly to Y in its formula and indirectly to X since X is derived from Y.
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FIGURE 4.42

Construction of a Corona Profile

The additional innovation in this family is the use of a Line-based Detail Item rig. We looked at several examples
of Detail Item rigs above. The rigs above were designed to allow disproportional scaling. In other words, the rig can
flex differently for X and Y. These used a standard Detail Item template. The example here uses a Line Based
template. A Line-based family is handy because you place it by clicking two points instead of one. This means that
you can build it to scale proportionally based on the length between the two clicks. However, once the rotation is
established with the two clicks, flexing it to a different proportion will often break it. So such rigs are best used in
proportional scaling families like this one. Feel free to open the nested Line-based family and explore. This rig gives
us a stable chord for our arc, so we can apply a parameter to the arc rise in much the same way that we did in the
“Create a Parametric Segmental Arch” topic above. Here I am deriving the Rise parameter as a set proportion of
the Y parameter. I am doing it that way to ensure that the “height” of the rise remains a constant proportion, but
still scales with the Base Diameter (which is built into the formula for Y).
The Corona profile family introduces some complexity, but compensates for this by also introducing some
additional flexibility. However, to make it truly flexible, it needs a few more enhancements. We’ll explore a detailed
example below, but let’s look at one more proportional example first.

SCOTIA
The Scotia profile shown in Figure 4.43 is also fully parametric and scales proportionally. It uses some of the same
techniques, but the approach is a little different and a little simpler.
SAMPLE! You can open a sample file named: 04_Scotia Profile.rfa.

A scotia is made up of a circular arc and elliptical arc. (As we noted above, a circle is really just a special case of an
ellipse, so we could argue that the scotia is two elliptical arcs, one circular in form, but this is a semantic distinction).
The approach shown in the dataset file and figure here uses an overall fixed proportion of 3 to 2 ½. To avoid having
lots of unnecessary parameters, a grid of reference planes is used with equality dimensions to flex them. There are
four reference planes set equally in both horizontal and vertical directions. A parameter called G is used to size one
bay of the grid in each direction, which in turn sizes the entire gird. To get the ½ bay in the X direction, the last
bay is subdivided again with an equality dimension and an extra reference plane. Once again the Base Diameter
parameter is used to scale the overall proportions. Like the Corona, in order to make the profile flexible enough to
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use in varying scenarios and families, a Multiplier parameter is introduced which is multiplied by Base Diameter
to give us G. G drives the size of the grid and family overall. A separate multiplier (Projection Mult) is used to
scale the size of the Projection. The arc and ellipse are simply aligned and locked to the reference planes (both the
centers and endpoints) using techniques covered previously.

FIGURE 4.43

Construction of a Scotia Profile

No rigs or trigonometry are necessary in this family. If you keep the goals of the family fairly limited you can often
avoid the more complex approaches. This makes the families easier to construct, maintain and troubleshoot. The
downside is that this family only scales in the proportion built into it. If you want it to scale disproportionally, you
would need to plan for Grid X and Grid Y. This might require more formulas, trigonometry or rigs. All are possible
of course, but sometimes it is easier to just save the family as a new name and build two or more, each with a
different proportion.

CREATE A VARIABLE CORONA PROFILE
If you look again at Figure 4.42 above, you can see that the shape of the Corona profile includes the curved portion
at the top and a flat extension below. In applications where this molding is to be used directly beneath another
molding or feature, this will work OK. But for many classical forms, such as the Tuscan capital we will be building
in the next chapter, it will be useful to have a small fillet above the curved portion of the corona. We could build
the fillet as a separate solid, but I think that in most cases, we could benefit from having the fillet as an integral part
of the Corona Profile. So let’s make that modification now in a copy of this family. Furthermore, at the start of this
topic, we also discussed that this particular profile has the proportion of 5/6 built in. Let’s also add another multiplier
and make it possible to vary the X and Y relationship of the curve.
1.

Open the 04_Corona Profile (Fixed Proportion) file.

2.

From the Application menu, choose Save As > Family.



For the name input: Corona Profile (Variable Proportion).

3.

Copy the upper horizontal reference plane up 0.030 units.



Add a dimension between the new reference plane and the one below it. (Be sure to dimension the reference
planes, not the profile lines).



Label the dimension with a new type-based parameter named: Y2. Group it under Constraints (see Figure 4.44).
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FIGURE 4.44

Copy the upper reference plane and label it with a new parameter

Recall from above, that the lower portion of this family is flexible based on multiplier parameters. Let’s do the same
for this new parameter. Instead of tying it directly to Base Diameter, we’ll add another multiplier parameter.
4.

Open the “Family Types” dialog.

5.

Click the Add button and create a new Number parameter.



Name it: Fillet Projection Mult.



Make sure it is a Type parameter and group it under Dimensions.



Set the value of Fillet Projection Mult to .030 (see the left side of Figure 4.45).

FIGURE 4.45

Create a new multiplier parameter for the fillet
6.

In the Formula field next to Y2, input: Base Diameter * Fillet Projection Mult and then click OK
(see the right side of Figure 4.45).



Flex the Fillet Projection Mult parameter.
Only the top reference plane should adjust at this point. If you flex the Base Diameter however, the entire family
will scale proportionally including the location of the new reference plane.

As noted above, this family uses a line based detail item rig. In my experiments, this is a novel approach, but
unfortunately seems to behave badly when you scale it disproportionally. So as long as you keep the ratio between
X and Y at 5/6, this family will perform nicely. However, to make this profile more flexible and useful to all the
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places we might need it, I think we should swap out the detail item family with the Single Curve Rig we used above.
This also means we will need another multiplier and to adjust the formulas. Since we are still in “Family Types”
let’s start there.
7.

Select XY Mult and on the right, click the Modify button.



Change the name to: Y Mult and then click OK.

Notice that upon renaming, it also renames this parameter in all the formulas as well.
8.

Create a new Number parameter called X Mult. Group it under Dimensions.



Set the value to match X, currently .104.



Change the Formula for X to: Base Diameter * X Mult (see Figure 4.46).

FIGURE 4.46

Create a new multiplier parameter for X

It is important that you use the same values that are here initially. If you use a different value, when you apply the
formula, Revit will try to flex the curve. This does not always go so well. Even with the same values, there may be
some round off in the decimals, so when we try to close the dialog, we will get a warning. This is why we need to
replace the line based rig with the more stable one we built above.
9.

Click OK to dismiss the dialog. Do not flex before closing.



In the warning that appears, click the Remove Constraints button.

10. Delete the top horizontal profile line, the arc and the detail item rig (see the left side of Figure 4.47).
11. On the Project Browser, expand Families > Detail Items.


Right-click the Guide Lines family and choose Reload.



Browse to the Chapter04 folder and choose the 04_Single Curve Rig.rfa file. (You can also use your version
created above if you prefer).



When prompted that the family already exists, choose the first option: Overwrite the existing version.

12. Expand the family name on Project Browser, drag Flex and drop it in the view window to place it onscreen. Align
and lock it on all four sides

TIP: This family comes in very large initially. You can set the X and Y size on the Properties palette to about .25
before aligning. This will reduce the size and prevent your having to zoom out very far. Once aligned and
locked, the sizes will match the context.
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For each alignment, first click one of the reference planes in the host family, and then click the nested shape
handle edge in the detail item family. Use TAB if necessary to get shape handle each time (see the right side of
Figure 4.47).

FIGURE 4.47

Delete the top portion and add the new rig


Select the detail item, on the Properties palette, uncheck the Visible checkbox.
This is the same process performed above in the “Cavetto” topic.

13. Extend the vertical line on the left to the new reference plane.


On the Create tab, click the Line tool and draw two new lines, one horizontal and one short vertical back down to
the rig.



Align and lock the two new lines to the reference planes (see the left two images in Figure 4.48).

Important: Make sure that for each alignment, you first click on a reference plane, not any other geometry or the
detail item, then click the line.

FIGURE 4.48

Adjust the shape of the profile
14. On the Create tab, click the Line tool and choose the Start-End-Radius arc.


Snap the endpoints to the ends of the detail rig.



Snap the radius when the arc show tangent to the other lines.



Align and lock the endpoints of the arc to the reference planes (see the third image in in Figure 4.48).
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Important: Make sure that for each alignment, you first click on a reference plane, not any other geometry or the
detail item, then click the endpoint of the arc. Use TAB if necessary.

15. Finally, add a dimension between the diagonal line in the detail item rig and the arc.


Label the dimension with the Rise parameter (see the right image in Figure 4.48).

Note: This procedure is the same one we followed above in the “Create a Parametric Segmental Arch” topic; see
Figure 4.25 above specifically.

When you deleted the lines above, you most likely lost some dimensions too. So be sure to replace any missing
dimensions. For example, the Y and Y2 dimensions. Figure 4.49 shows the completed Corona Profile with its
“Family Types” showing the parameters and formulas.

FIGURE 4.49

The completed Corona Profile and its parameters
16. Save and close the file.

CATCH UP! You can open a file completed to this point named:
05_Corona Profile (variable Proportion).rfa.

CONTROLLING A SPLINE
All of the examples so far have used some combination of arcs, circles and ellipses. To wrap up our inventory of
curves and techniques to parametrically control curves, we’ll take a brief look at splines. In the traditional family
editor, the spline is the last type of curve that we have. The spline in the traditional family editor is a Bezier spline.
According to Wikipedia:
A Bézier curve is a parametric curve frequently used in computer graphics and related fields… In vector graphics, Bézier
curves are used to model smooth curves that can be scaled indefinitely.
SAMPLE! You can open a sample file named: 04_Traditional Spline.rfa.
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In Revit, a spline is drawn as a series two or more control points. Splines are open curves in Revit; there is no “close”
option. You can have as many intermediate points between the start and end point as required to shape the curve.
With a little practice, you can create fairly complex curves from splines with little effort. When creating 3D forms
from splines, the surfaces will remain smooth; no facets or edges. This can be a big advantage for certain types of
forms. If you need a hard edge, consider other types of lines or create more than one spline (see the top portion of
Figure 4.50).

FIGURE 4.50

Working with Splines

Another interesting and useful characteristic of splines is that if you drag either endpoint, the entire spline will
stretch and scale proportionally at the same time. This means that as you stretch the implied line that connects the
start and end points, your spline will maintain its shape and scale proportionally as it grows larger or smaller. You
do not need to do anything special to achieve this behavior. This is the built-in behavior of splines (and as the
Wikipedia definition above noted, of Bezier curves in general).
If you wish to actually reshape your spline at one of its ends, make sure you press TAB to cycle the selection into the
open circle at the grip point. The open circle is the control handle, while the solid dot is the endpoint. Endpoints
will scale the spline. The open circles reshape it (see the bottom of Figure 4.50).
Note also in the figure that you can attach a dimension to the endpoints. This allows you to scale your spline using
parameters and labeled dimensions. You can attach the dimension directly to the endpoints (TAB as necessary) or
you can align and lock the endpoints to reference planes and flex them that way instead.
Given the built-in behavior of splines to scale proportionally when stretching the endpoints, it is possible to use
them to shape your profiles and potentially avoid some of the techniques covered above. You can achieve a close
approximation of many classical forms in this way, but it will not be completely precise. In other words, most of
the moldings previously discussed use arcs: segments of circles. Splines can approximate these curves very closely,
but will not be perfectly circular. If you build your splines carefully would anyone notice the difference? Perhaps
not, but I much prefer to limit the use of splines to forms that do not use circles, arcs, and ellipses. For example the
many organic forms in the Corinthian capital or the very subtle curvature of a column shaft’s diminution. In later
chapters I will show some of these examples. In the meantime, you are welcome to try to replicate some of the
moldings covered here using splines in place of the arcs and decide for yourself.
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COMBINING STRATEGIES
By now you should be feeling pretty comfortable with the various techniques and procedures needed to get curved
forms to flex reliably in parametric Revit families. In this topic, we will perform one more exercise and use this as
an opportunity to combine a few of the techniques we have learned together into a single family.
Let’s create an arched doorway opening. This will be a simple example to illustrate how the pieces might fit together.
We could approach this family in a few different ways, so naturally the first step should always be to do some initial
planning. You can do this on a sketchpad, or directly in Revit.
What we would like here is a door family that has an arched shape. We can use any of the shapes discussed above
in the “Arches” topic. In this example we will look at a new shape not covered above. This one will be a three-center
arch. It combines three arcs together into a form that closely approximates an ellipse. (Feel free to use an elliptical
arc like the one shown above instead if you prefer).
For this exercise, we will create the opening, a door with adjustable swing and a molding that surrounds it on both
sides. This will incorporate almost everything previously discussed in this chapter in a single family! You are welcome
to take it further following the completion of the tutorial that follows.

THREE CENTER ARCH
Let’s start with the three center arch. A diagram of the shape is shown in Figure 4.51. The geometry is pretty simple.
The two arcs on the left and right are 60° arcs with centers along the spring line. The middle arc is similar to our
segmental arch above. We could use either rigs or formulas to construct this one. We’ll go with a formula since the
angles are fixed at 60° which makes the formula very simple.

FIGURE 4.51

Construction of a Three-Center Arch
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We can create a new door family and build the sketch of this form directly in the door family. To do so, select the
Opening Cut object that appears in the default Door.rft template and edit its sketch. However, let’s build a profile
family instead. You cannot use a profile family to shape the Opening Cut, so we will delete it. In its place, we’ll use
a Void Sweep that uses our profile. The reason for this approach, is we can reuse the same profile to create and
arched shaped door panel. In this way, you will be able to edit one sweep profile and change the shape of both the
opening and the door itself.
1.

From the Application menu, choose New > Family.



Choose the template: Profile.rft.
A copy of this file is provided in the Template/OTB folder with the book’s dataset files.



Save the file as: Three Center Arch Profile.

2.

Add a series of reference planes: four horizontal and six vertical.



Create the four horizontal ones above the Center (Front/Back) reference plane.



For the vertical ones, create three on each side.



Add dimensions as shown in Figure 4.52.



On the Properties palette, name the reference planes indicated.

Draw the vertical reference planes that have equality dimensions first. Then add the Width parameter. Add X1 after
this. In the other direction, establish Height first, then R2 and its reference plane and finally Y1 and their reference
planes.

FIGURE 4.52

Create the three center arch profile family and set up reference planes and dimensions

CATCH UP! You can open a file completed to this point named: 04_Three Center Arch Profile (Ref).rfa.
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3.

Create the following parameters and assign them to the dimensions as shown (see Table 4.3).

TABLE 4.3

Parameter

Type

Group Under

Formula

Width

Length

Dimensions

Height

Length

Dimensions

X1

Length

Constraints

Width / 6

Y1

Length

Constraints

X1 * tan(60)

R1

Length

Constraints

X1 * 2

R2

Length

Constraints

R1 * 2

4.

Flex everything to ensure it is working properly.

5.

Using Figure 4.51 above as a guide, on the Create tab, click the Line tool and then the Center-ends Arc icon.
Draw the three arcs required.



Draw the two arcs on the sides first. Align and lock the endpoints in both directions. (Eight total: two arcs, each
with two endpoints, both X and Y).



Select both arcs and on the Properties palette, check Center Mark Visible.



Align and lock the centers in both directions.

6.

Select both arcs. On the View Control Bar, click the sunglasses icon and choose Hide Element.

7.

Draw the remaining arc. Turn on its center mark, align and lock the endpoints and center mark.
If an error appears about over constraining the sketch, simply click Cancel and ignore that point.

8.

Reset the Temporary Hide/Isolate and then open the “Family Types” dialog.



Flex the Width parameter to test the family.



Set it back to 4.000 when you are sure it is flexing properly.

You should get in the habit of creating a default family type for every family you create. The reason is that if you do
not create one, Revit will create one for you and its name will be the same name as the family. This is not ideal1.
You can name your default type anything you like. If the family is intended to nest into other families and will have
its parameters driven by associated family parameters, as noted in the previous chapter, I like to name the default
type: “Flex.” This name basically tells me that it is the default family and that I intend to nest it into other families
and associate its parameters with parent parameters in the host family. Feel free to use a different name for your
default type if you don’t like the name Flex.
9.

On the right, click the New button (under Family Types) and name it: Flex. Close the “Family Types” dialog.

10. Draw the remaining three straight lines on the Left, Right and Center (Front/Back) reference planes. Align and
lock them.
11. Save the family.

1
I had an interesting discussion with Aaron Maller who tech edited this book. He told me that they deliberately don’t create a family type
for those families that will be used with a <Family Types> parameter. When you don’t have a family type, the drop-down displayed by Family
Types parameters will list only the family name and not: Family Name:Type Name. This is certainly a nicer experience when using family
types. So if you are building a family that will be nested into another family and used in conjunction with a Family Types parameter, then I
agree with Aaron, don’t create a type. As you may recall from the “Family Types Parameters” topic in the previous chapter, we will not
actually be using the Family Types parameter in the lessons in this book.
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CATCH UP! You can open a file completed to this point named: 04_Three Center Arch Profile.rfa.

COMPOUND MOLDING PROFILE
The next step is to look at the molding profile. To save some time, the family has been provided already. The
molding uses both a Cyma Reversa and Ovolo as well as some straight fillet portions. Given the complexity of this
shape it uses the nested detail item rigs that we have already built. This will avoid having lots of parameters and
complex formulas (see Figure 4.53).

FIGURE 4.53

Understanding the Door Molding Profile Family

FILE PROVIDED! Please open a sample file named: 04_Door Molding Profile (Rig).rfa.

As you can see, this family contains MANY reference planes. When building such a family, it is recommended to
approach it systematically. Have a good sketch handy and build the reference planes in small groups. Notice that
they are built to varying lengths. This approach provides visual hierarchy onscreen. This is critical to helping you
keep everything straight both when building and later when editing the family. Naming reference planes is also
important, but you may notice that this family has few named reference planes. The reality is that coming up with
meaningful names for every reference plane in an example like this provides a diminishing return when compared
to the time it would take to actually select and name them. Your results may vary and you are welcome to name
them if you wish.
Notice the heavy reliance on equality dimensions. Many of the reference planes in this family are used simply to
leverage equality dimensions rather than parameters and formulas. For example, let’s say you have a distance that
should be one fifth some other distance. You can create a parameter and add a formula that calculates the correct
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value for you, or you can place a series of reference planes and then put an equality dimension to control them.
Either approach will flex properly, but the equality approach avoids many extra parameters.
Notice the two previously discussed rigs used to shape the curved portions of this molding. The rigs were inserted,
aligned and locked to the appropriate reference planes.
If you open “Family Types” notice that there is only one formula! This ties X and Y together to maintain the desired
proportion. There are two additional features to note here: one is the presence of two “Offset” parameters. All of
the dimensions in this family are actually associated to two reference planes that are directly on top of the default
Center (Left/Right) and Center (Front/Back) ones. These two parameters are set to zero, but can be flexed to move
the entire profile away from the insertion point. The reason to do this has to do with a limitation in swept forms.
You can shift the profile of a sweep when inserting it, however, you cannot do so parametrically. So whatever shift
you apply is fixed in the sweep. If you want to vary the offset value from one type to another or one family to
another, you can use these two offset parameters instead.
Finally, there is a Multiplier parameter that allows this profile to scale disproportionately. It applies to the X value
only. So it controls the relationship between X and Y. For example, the default Multiplier is set to 4. This makes
the proportion between X and Y 1 to 4. Try different values if you would like to experiment.

ARCHED DOOR FAMILY
In the final step, we will utilize the two profile families in a new door family. Since we built a door family previously,
we can start with that file instead of building from scratch. If you prefer, you can repeat the steps covered above in
the “Create a Door Family with Variable Swing” topic instead of starting with the provided file.
1.

Open the file: 04_Door w Variable Swing.rfa.

2.

Save the file as: Door w Three Center Arch.

The standard door family template includes an Opening Cut (which makes the hole in the wall) and some trim.
We will delete both of these.
3.

Delete both trim elements and the Opening Cut.
The hole in the wall and some of the dimensions will also disappear (see Figure 4.54).

FIGURE 4.54

Delete the Opening Cut and the trim
4.

On the Insert tab, click the Load Family button.
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Load both profile families into the door family. (04_Door Molding Profile (Rig).rfa and 04_Three Center Arch Profile.rfa).

TIP: Use the

CTRL

key and select both families to load in a single step.

For the Three Center Arch Profile family, you can use your own version created above or the one provided.
CATCH UP! You can open a file completed to this point named: 04_Door w Three Center Arch (01).rfa.

Since we removed the Opening Cut, we need to create a new opening in the host wall. We will use a void form for
this. Specifically a Void Sweep so we can use our profile family to shape it.
5.

On the Create tab, click the Void Forms dropdown and choose Void Sweep.

6.

Click the Sketch Path button and draw a single line segment across the thickness of the wall (draw along the
Center (Left/Right) reference plane and snapping to the face of wall on each side).

TIP: In this example we are making the void flush with the wall, but if you intend to build a door like this for actual
projects, you might want to consider making the void extend past the faces of the wall to ensure that it will
always behave as expected in projects.



Align and lock the endpoints of the line to the faces of the wall. Use the



Align and lock the sketch line to the Center (Left/Right) reference plane as well (see Figure 4.55).

TAB

key as required.

FIGURE 4.55

Sketch the path and align and lock it
7.

Finish the sketch and then on the Modify | Sweep tab, click the Select Profile button.



From the Profile dropdown, choose Three Center Arch Profile:Flex.



Open the Interior elevation view.

Notice that the arch is down near the floor. Also, the shape of the profile does not have the correct height or width
either. We will address those issues after we complete the sweep (see the left side of Figure 4.56).
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FIGURE 4.56

After completing the void it is the wrong size and unattached to the wall
8.

On the ribbon, click the Finish Edit Mode button.

9.

Open the 3D view. Notice that the void is not cutting anything.



On the Modify tab, click the Cut tool.



Pick the wall, then the void.



Click the Modify tool to complete the command (see the left side of Figure 4.56).

10. On the Project Browser, Beneath the Families branch, expand Profiles, then the Three Center Arch Profile.


Right-click on Flex and then choose Type Properties.



Next to the Width parameter, click the small Associate Family Parameter button. In the “Associate Family
Parameter” dialog, choose Width and then click OK.



Repeat for Height and then click OK again (See Figure 4.57).

FIGURE 4.57

Associate Family Parameters to make the Profile match the door size

CATCH UP! You can open a file completed to this point named: 04_Door w Three Center Arch (02).rfa.

You should now have a hole in your wall that matches the shape of our custom profile and the dimensions of the
door family. If you flex the Width and Height, the shape of the arch will flex accordingly. Now let’s build a 3D
door panel from the same profile.
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Make sure that the Ref. Level floor plan view is active.
11. On the Create panel, on the Work Plane panel, click the Set button.


In the “Work Plane” dialog, click the Pick a plane option and then click OK.



Click the diagonal reference line to make it the active Work Plane.

12. On the Create panel, click the Sweep button.
13. Click Sketch Path and then draw a small straight path perpendicular to and away from the midpoint of the
reference line. (Draw towards the doorway at a 45°).


Add a dimension and label it with the Thickness parameter.

TIP: It is best to draw the sketch line the same length as the parameter before you apply the label. That is 2" in this
case. This way, when you apply the label, it will not also need to flex.



You can also add another dimension in the other direction from the endpoints of the reference line and toggle the
equality (see Figure 4.58).

TIP: the easiest way to get the equality dimension is to zoom in, click the first witness line on the sweep path
sketch line. Then click at each of the endpoints of the reference line. If you start at the endpoints, it is much
harder to get the correct points.

FIGURE 4.58

Sketch the path of the panel sweep, constrain and parameterize it
14. Finish the path and assign the Three Center Arch Profile:Flex profile to it. Finish the Sweep.
15. Open the 3D view called View 1 and flex.

CATCH UP! You can open a file completed to this point named: 04_Door w Three Center Arch (03).rfa.

The final step is to add the moldings around the door opening. These will also be a sweep, but this time we will use
the Pick Path option to pick the edges of the 3D door opening.
Stay in the 3D view for this step.
16. Create a new Sweep. For the path, click the Pick Path button.
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Carefully click the edges around the opening on one side of the door. There will be five edges total—three arc
and two lines.



Click Finish and then select the Profile: Door Molding Profile (Rig):Flex.



If necessary, rotate and flip the profile using the controls on the Options Bar.

17. Click Finish when done.
18. Repeat the entire process on the other side.

You will need to actually repeat the steps on the other side. If you mirror it, the sweep will lose its association to the
3D edges. So create a new sweep and pick new edges for the path. When you are finished, you can flex it to make
sure everything works. While you are in the “Family Types” dialog, add a few family types and assign some materials
to the geometry if you like. Your final result should look something like Figure 4.59.

FIGURE 4.59

The finished arched door family

CATCH UP! You can open a file completed to this point named: 04_Door w Three Center Arch.rfa.

Naturally there is much more we could do with this door family. We could add a low detail version of the molding
for medium detail and turn it off completely in coarse. We could add a vision panel to the door panel. We could
add 2D graphics to the elevations and plan view. We could create a closed 3D version or simply rely on the swing
parameter. There are transoms, pilasters, other moldings and any number of other enhancements you could
consider.
I will leave you with those suggestions and allow you to consider them as an additional exercise.
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SUMMARY
We have covered a lot of ground in last three chapters. It does take some time to digest everything,
but the skills discussed here and in the previous two chapters will be the cornerstone of the lessons
that follow in the coming chapters. Make sure you are comfortable with the concepts and techniques
before continuing.


Curves take a little more effort to constrain in the family editor than straight lines.



Circles and 90° arcs usually need little more than constraining the center point.



Angles other than 90° can be effectively constrained by aligning and locking the
endpoints to reference planes in both directions.



For ellipses and elliptical arcs, use the icon to make the temporary dimension
permanent to create dimensions and label them for the axes in each direction.



Rotation is best controlled with a reference line instead of reference planes.



Be sure to align and lock the endpoints of the reference line to an intersection of two
reference planes to fix the center of rotation. Then use an angular parameter to
control rotation of the reference line.



For segmental arches or curves where you have a chord length, you can dimension
directly to the curve to control the “rise” above the chord. This allows the center
point to move. Be sure to align and lock the endpoints of the arc.



When creating complex molding shapes with arcs that do not have fixed center
points, you can use trigonometry to calculate the locations of the center point
reference planes. This is very stable.



Alternatively, you can build a rig that flexes along a diagonal and use it to help shape
the curve.



Profile families are the preferred way to build your standard molding shapes.



You can make your profile families flexible by introducing “multiplier” parameters.
This will make it possible to flex them to different proportions.



Splines offer an alternative approach to curvature. The shape of the spline is
maintained when the endpoints are flexed. This allows you to create complex
freeform shapes and scale them proportionally.

CUA CLASS OF ’90 SKETCHING
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